
 

РУКОВОДСТВО ПО НАЧАЛУ РАБОТЫ 

PXIe-5423 
PXI генератор сигналов:16 разрядов, полоса частот 40 МГц 

 
В данном документе рассматривается установка, конфигурирование, тестирование и 

применение PXIe-5423. PXIe-5423 поставляется с программным драйвером NI-FGEN, 

который вы можете использовать для программирования модуля. 

Примечание: Перед началом работы установите и сконфигурируйте ваши шасси 

и контроллер. 

Предупреждение! Такая иконка означает предупреждение, советующее 

обратиться к разделу документации отмеченного таким символом. 

Внимание! Защита PXIe-5423 может быть повреждена при использовании его 

способами, не описанными в настоящем документе. 
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Электромагнитная совместимость 
Данный продукт протестирован и соответствует требованиям и ограничениям нормативных 

документов по электромагнитной совместимости (EMC), приведенным в технических 

характеристиках продукта. Эти требования и ограничения предоставляют достаточную 

защиту от вредных помех при эксплуатации продукта в надлежащей электромагнитной среде. 

Продукт предназначен для использования в промышленных условиях. Однако в случае если 

продукт подключен к периферийному устройству или тестируемому объекту, или если 

продукт используется в жилых или коммерческих помещениях, могут возникнуть вредные 

помехи. Для минимизации помех приему теле- и радиосигналов и предотвращения 

неприемлемого ухудшения характеристик, устанавливайте и используйте данный продукт в 

строгом соответствии с инструкциями, приведенными в настоящем документе. 

Кроме того, любые внесенные в продукт изменения или модификации, не одобренные в 

явном виде National Instruments, могут лишить вас права эксплуатировать продукт согласно 

местным нормативным правилам. 

Внимание! Для обеспечения соответствия указанной электромагнитной 

совместимости используйте данный продукт только с экранированными кабелями 

и аксессуарами. 

Внимание! Для обеспечения указанных характеристик электромагнитной 

совместимости длина всех кабелей ввода-вывода не должна превышать 3 м  

(10 футов). 

Проверка системных требований 
Для использования PXIe-5423 ваша система должна удовлетворять определенным 

требованиям. 

Для получения дополнительной информации о минимальных и рекомендуемых системных 

требованиях, а также поддерживаемых средах разработки приложений обратитесь к 

документу readme выбранного вами программного обеспечения. Документы readme доступны 

на DVD с драйверами и онлайн на сайте ni.com/updates. 

Распаковка комплекта  
На рисунке ниже показано содержимое комплекта PXIe-5423. 

  

http://www.ni.com/updates
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Рисунок 1. Содержимое комплекта PXIe-5423 

 

1. PXIe-5423 

2. Руководство по началу работы с PXIe-5423 (этот документ) 

3. Документ для пользователей Maintain Forced-Air Cooling Note to Users 

Внимание! Для предотвращения повреждения модуля электростатическим 

разрядом заземлитесь с помощью заземляющего браслета или взявшись за 

заземленный предмет, например, шасси компьютера. 

1. Коснитесь антистатической упаковкой металлической части шасси компьютера. 

2. Достаньте модуль из упаковки и проверьте, нет ли плохо закрепленных компонентов или 

других  признаков повреждений. 
 

Внимание! Никогда не прикасайтесь к неизолированным контактам или 

разъемам. 

Примечание: Не устанавливайте модуль при обнаружении любых повреждений. 

 

3. Распакуйте из комплекта остальные элементы и документацию. 

Когда модуль не используется, храните его в антистатической упаковке. 

Прочее оборудование 
Для работы с PXIe-5423 требуется еще несколько элементов, не включенных в комплект 

поставки. Для работы вашего приложения могут потребоваться дополнительные элементы, 

не включенные в комплект поставки. 

Необходимые элементы 

 Шасси PXI и документация на него. 

 Контроллер PXI или ПК с устройством для дистанционного управления системой 

PXI, удовлетворяющий системным требованиям, приведенным в данном 

руководстве и в документации на шасси. 

Дополнительные элементы 

 Блокиратор слотов PXI (шифр изделия NI 199198-01) 

 Коннекторный блок SCB-19 (шифр изделия NI 785642-01) 

 Экранированный кабель SHH19-MH19-AUX с несимметричными линиями 

подключения, 1 м (шифр изделия NI 784091-01)  

Посетите сайт ni.com  для получения дополнительной информации об этих дополнительных 

элементах. 

http://www.ni.com/


 

4 | ni.com | Начало работы с PXIe-5423 

Окружающая среда 

Убедитесь, что среда, в которой вы используете PXIe-5423, удовлетворяет следующим 

характеристикам. 

Максимальная высота над уровнем моря 2 000 м (800 мбар) (при температуре 

окружающей среды 25 °C) 

Степень загрязнения 2 

Диапазон температур при эксплуатации от 0 °C до 55 °C (Протестировано в 

соответствии со стандартами IEC 60068-2-1 и 

IEC 60068-2-2. Удовлетворяет требованиям 

MIL-PRF-28800F, класс 3 для нижнего предела 

температуры, и класс 2 для верхнего предела 
температуры). 

Относительная влажность при 

эксплуатации 

от 10% до 90%, без конденсата 

(Протестировано в соответствии с  

IEC-60068-2-56) 

Для эксплуатации только в помещении. 

Дополнительная информация  

Обратитесь к документу PXIe-5423 Specifications на сайте ni.com за полным списком 

характеристик 

 

Инсталляция программного обеспечения  

Для инсталляции программного обеспечения NI на компьютер вы должны обладать правами 

администратора. 

1. Установите среду разработки приложений, например, LabVIEW или 

LabWindows™/CVI™. 

2. Посетите страницу ni.com/downloads/drivers и выполните поиск по ключевому слову  

NI-FGEN. 

3. Скачайте последнюю версию NI-FGEN, щелкнув по пункту Download и запустив 

исполняемый файл (.exe). 

4. Следуйте указаниям программы инсталлятора. 

Примечание: Во время установки в Windows могут отображаться сообщения о 

доступе и безопасности. Примите предлагаемые варианты для завершения 

установки. 

5. После завершения установки в появившемся диалоговом окне, предлагающем 

перезагрузить, выключить или перезагрузить позже, выберите Restart. 

  

http://www.ni.com/manuals
http://www.ni.com/manuals
http://www.ni.com/downloads/drivers
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Установка PXIe-5423 
Внимание! Для предотвращения повреждения модуля PXIe-5423, вызванного 

загрязнением или электростатическим разрядом, держите модуль за края или 

металлический кронштейн. 

Внимание! Очищайте устройство мягкой, неметаллической кисточкой. 

Убедитесь, что устройство полностью сухо и свободно от загрязнений, прежде 

чем начинать его повторное использование. 

PXIe-5423 представляет собой однослотовый модуль с одним разъемом для объединительной 

панели. Модуль может быть установлен в любой совместимый с PXI Express слот. 

1. Перед установкой модуля убедитесь, что источник питания шасси подключен к сети 

переменного тока. 

Сетевой кабель заземляет шасси и защищает его от электрических повреждений во время 

установки модуля. 

2. Выключите питание шасси. 

3. Перед установкой проверьте, не погнуты и не повреждены ли контакты слота 

объединительной панели. Не устанавливайте модуль, если объединительная панель 

повреждена. 

4. Разместите шасси таким образом, чтобы входные и выходные вентиляционные отверстия 

были открыты. 

Для получения более подробной информации об оптимальной установке шасси 

обратитесь к документации на шасси. 

5. Снимите черные пластиковые колпачки со всех крепежных винтов на передней панели 

модуля. 

6. Определите в шасси поддерживаемый слот. На рисунке ниже приведены обозначения 

типов слотов в шасси. 

Рисунок 2. Обозначения совместимости шасси 

 

1. Слот системного контроллера PXI Express 

2. Периферийный слот PXI 

3. Гибридный периферийный слот PXI Express 

4. Слот синхронизации системы PXI Express 

5. Периферийный слот PXI Express 

 

Модули PXIe-5423 могут устанавливаться в периферийные слоты PXI Express, гибридные 

периферийные слоты PXI Express и в слоты синхронизации системы PXI Express. 

7. Прикоснитесь к любой металлической части шасси, чтобы снять статический 

электрический заряд. 

8. Убедитесь в том, что ручка эжектора находится в нижнем (незащелкнутом) положении. 

9. Поместите края модуля в направляющие вверху и внизу шасси. Задвиньте модуль в слот 

до упора. 
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Рисунок 3. Установка модуля  

 

1. Шасси 

2. Аппаратный модуль 

3. Ручка эжектора в нижнем положении (эжектор не защелкнут) 

10. Зафиксируйте модуль, подняв вверх ручку эжектора. 

11. Закрепите переднюю панель модуля в шасси с помощью винтов на передней панели. 

Примечание: Затягивание верхнего и нижнего винтов увеличивает механическую 

прочность, а также обеспечивает электрический контакт передней панели c шасси, 

что может улучшить качество сигнала и электромагнитные характеристики. 

12. Закройте все пустые слоты панелями-заглушками EMC или блокираторами слота для 

максимизации потока охлаждающего воздуха, в соответствии с требованиями вашего 

приложения. 

13. Включите питание шасси. 

 

Дополнительная информация  

Почему светодиод ACCESS выключен, когда шасси включено? на странице 14 
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Схема расположения контактов и светодиоды 
PXIe-5423 
Передняя панель 

Обратитесь к следующим рисунку и таблицам для получения информации о разъемах и 

светодиодах на передней панели одно- и двухканальных модулях PXIe-5423. 
 

 

Таблица 1. Описание сигналов PXIe-5423 

 Сигнал Тип разъема Доступ Описание 

1 CH 0 SMA Выход Разъем генерируемого аналогового сигнала. 

2 CH 1 

3 PFI 0 Вход/ 

выход 

Импортирует сигналы цифрового запуска и 

экспортирует сигналы цифровых событий. 

Импортируемые сигналы могут использоваться 

для запуска или пошаговой генерации сигналов, 

а экспортируемые сигналы событий отражают 

состояние движка генерации. 

4 PFI 1 

5 AUX 0 MHDMR Маршрутизирует сигналы цифрового запуска и 

событий для восьми двунаправленных линий 
PFI, предоставляет +3,3 В источника питания. 

Светодиод ACCESS указывает на базовый статус оборудования. 
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Таблица 2. Светодиодные индикаторы ACCESS PXIe-5423 

 Цвет светодиода Индикация 

6 Выключен  PXIe-5423 еще не работает. 

Желтый К PXIe-5423 осуществляется доступ. 

Зеленый  PXIe-5423 готов к программированию с помощью NI-FGEN 

Светодиод ACTIVE указывает на состояние оборудования PXIe-5413. 

Таблица 3. Светодиодные индикаторы ACTIVE PXIe-5423 

 Цвет 
светодиода 

Индикация 

7 Выключен PXIe-5423 не генерирует сигнал. 

Желтый PXIe-5423 активирован и ожидает сигнала запуска. 

Зеленый PXIe-5423 получил сигнал запуска и генерирует сигнал. 

Красный PXIe-5423 обнаружил ошибку. NI-FGEN должен получить доступ к  

PXIe-5423 для определения причины ошибки. Светодиод остается 

красным, пока ошибка не устранена. Среди возможных ошибок: 

 ФАПЧ (PLL) разомкнута: PXIe-5423 обнаружил потерю синхронизации 

ранее синхронизированной ФАПЧ. ФАПЧ, не синхронизированная при 

сбросе, не дает ошибки. 

 Питание PXIe-5423 отключилось, поскольку температура внутри модуля 

превысила максимальный предел. Необходимо устранить превышение 

температуры и перезагрузить оборудование. Для перезагрузки 

оборудования вызовите функцию niFgen Reset Device или 

niFgen_ResetDevice.1  

 

Разъем AUX 0 

Примечание: Разъем AUX 0 совместим со стандартным HDMIТМ типа C кабелем 

стороннего производителя, но порт AUX 0 не является интерфейсом HDMI, и 

указанная характеристика разъема AUX 0 не гарантируется при использовании 

кабеля HDMI сторонних производителей. Используйте кабели NI SHH19-MH19-

AUX для всех подключений AUX 0. Не подключайте порт AUX 0 PXIe-5423 к 

порту HDMI другого устройства. NI не несет ответственность за повреждения, 

вызванные подобным подключением сигналов. 

На рисунке и в таблице ниже приведена информация о контактах разъема AUX 0 модуля 

PXIe-5423. 

                                                           
1
 Для получения дополнительной информации о поддержании ограничений температуры внутри  

PXIe-5423 обратитесь к документу Maintain Forced-Air Cooling Note to Users, включенному в комплект 
поставки модуля PXIe-5423, или на сайте ni.com. 

http://www.ni.com/
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Таблица 4. Описание сигналов на контактах AUX 0 

Контакт Сигнал Описание 

1 GND Опорный общий для сигналов 

2 NC Не подключен 

3 GND Опорный общий для сигналов 

4 GND Опорный общий для сигналов 

5 NC Не подключен 

6 GND Опорный общий для сигналов 

7 GND Опорный общий для сигналов 

8 AUX 0/PFI 0 Двунаправленная линия PFI 

9 AUX 0/PFI 1 Двунаправленная линия PFI 

10 GND Опорный общий для сигналов 

11 AUX 0/PFI 2 Двунаправленная линия PFI 

12 AUX 0/PFI 3 Двунаправленная линия PFI 

13 GND Опорный общий для сигналов 

 
  



 

10 | ni.com | Начало работы с PXIe-5423 

Таблица 4. Описания сигналов на контактах AUX 0 (продолжение) 

14 AUX 0/PFI 4 Двунаправленная линия PFI 

15 AUX 0/PFI 5 Двунаправленная линия PFI 

16 AUX 0/PFI 6 Двунаправленная линия PFI 

17 AUX 0/PFI 7 Двунаправленная линия PFI 

18 +3,3 V Питание +3,3 В (максимум 200 мА) 

19 GND Опорный общий для сигналов 

 

Схема расположения контактов коннекторного блока 
SCB-19 для PXIe-5423  
NI рекомендует использовать коннекторный блок SCB-19 для подключения цифровых 

сигналов к разъему AUX 0 на передней панели. На рисунке и в таблице ниже приведена 

информация о сигналах SCB-19 при подключении к разъему AUX 0 на передней панели. 

 

Таблица 5. Описание сигналов SCB-19 

Контакт Сигнал Описание 

1 PFI 0 Двунаправленная линия PFI 

2 PFI 1 Двунаправленная линия PFI 

3 PFI 2 Двунаправленная линия PFI 

4 PFI 3 Двунаправленная линия PFI 

5 NC Не подключен 

6 NC Не подключен 

7 NC Не подключен 

8 NC Не подключен 

9 PFI 4 Двунаправленная линия PFI 

10 PFI 5 Двунаправленная линия PFI 

11 PFI 6 Двунаправленная линия PFI 

12 PFI 7 Двунаправленная линия PFI 

13 +3,3 V Питание +3,3 В (максимум 200 мА) 

<14..26> GND Опорный общий для сигналов 
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Конфигурирование PXIe-5423 в MAX 

Используйте Measurement & Automation Explorer (MAX) для конфигурирования вашего 

оборудования NI. MAX сообщает другим программам об установленных в системе 

устройствах NI и их конфигурациях. MAX автоматически инсталлируется с NI-FGEN. 

1. Запустите MAX. 

2. В дереве Configuration разверните пункт Devices and Interfaces, чтобы увидеть список 

установленных устройств NI. 

Установленные модули появляются под названием связанного с ними шасси. 

3. Разверните в дереве элемент Chassis. 

MAX перечисляет все модули, установленные в шасси. Имя вашего модуля по 

умолчанию может быть разным. 

Примечание: Если вы не видите ваш модуль, нажмите на клавишу <F5> для 

обновления списка установленных модулей. Если модуля по-прежнему нет в 

списке, выключите питание системы, убедитесь, что модуль установлен 

правильно, и выполните перезагрузку. 

4. Запишите имя вашего устройства, назначенное MAX. Вы используете его при 

программировании PXIe-5423. 

5. Выполните самотестирование устройства. Для этого выберите устройство в дереве 

конфигурации и щелкните по кнопке Self-Test на панели инструментов MAX. 

Самотестирование из MAX выполняет базовый тест аппаратных ресурсов. 

 

Дополнительная  

Что делать, если PXIe-5423 не появляется в MAX? на странице 14 

Что делать, если PXIe-5423 не прошел самотестирование или самокалибровку? на 

странице 15 
 
  



 

12 | ni.com | Начало работы с PXIe-5423 

Самокалибровка PXIe-5423 
При самокалибровке с помощью встроенного высокоточного АЦП калибровки PXIe-5423 

подстраивается под изменения условий окружающей среды. Выполните полную 

самокалибровку после первой установки PXIe-5423. 

1. Установите PXIe-5423 и позвольте ему прогреться в течение 15 минут. 

Примечание: Прогрев начинается после включения питания шасси PXI 

Express и полной загрузки операционной системы. 

2. Выполните самокалибровку PXIe-5423 щелчком по кнопке Self-Calibrate в MAX или 

вызвав niFgen Self Cal или niFgen_SelfCal. 

Модули PXIe-5423 откалиброваны на заводе с помощью внешних средств калибровки, 

однако вы должны выполнить самокалибровку в любой из следующих ситуаций: 

 После первой установки PXIe-5423 в шасси 

 После установки, извлечения или перемещения любого модуля в шасси 

 Когда PXIe-5423 находится в среде, температура которой отличается более чем на ± 5 ° C 

или если температура PXIe-5423 изменяется более чем на ± 5 °C от температуры, при 

которой выполнялась предыдущая самокалибровка 

 Для периодической коррекции небольших изменений характеристик, возникающих при 

старении продукта 
 

Дополнительная информация  

Что делать, если PXIe-5423 не прошел самотестирование или самокалибровку? на 

странице 15 
 

Генерация сигналов с использованием 
программной лицевой панели NI-FGEN 
Выполните следующие действия для генерации стандартного сигнала или сигнала 

произвольной формы с использованием программной лицевой панели NI-FGEN (SFP): 

1. Запустите NI-FGEN SFP. 

2. Убедитесь, что PXIe-5423 появляется на экране NI-FGEN SFP. 

3. Если вы используете двухканальный PXIe-5423, выберите канал из списка Channel. 

Для генерации сигналов на нескольких каналах повторите пункты 3 и 4 для загрузки 

сигнала в каждый канал. 

4. Щелкните по одной из следующих кнопок Mode и выполните следующие связанные 

пункты для настройки вашего модуля PXIe-5423 на генерацию сигналов: 

 Standard Function Output  - генерация стандартных функций 

1. Щелкните по одной из кнопок шаблонов сигналов для выбора типа стандартной 

генерируемой функции. 

2. Выберите переменную из выпадающего списка. 

3. Задайте частоту, амплитуду, смещение по постоянному току, фазу и 

коэффициент заполнения с помощью соответствующих регуляторов. 
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 Single Arbitrary Waveform Output  - генерация сигнала произвольной формы 

1. Щелкните по кнопке Current Waveform Pattern  (текущий шаблон сигнала), 

а затем - Load Waveform from disk (загрузка сигнала с диска). 

Откроется диалоговое окно выбора файла, в котором представлены примеры 

файлов сигналов. 

Примечание: Вы можете также загрузить сигнал, выбрав пункт меню 

File»Load New Waveform. 

2. Выберите файл сигнала и щелкните по кнопке OK. 

3. Появятся диалоговые окна File Load и Waveform Preview. Вы можете закрыть или 

свернуть окно предварительного просмотра сигнала. 

В диалоговом окне File Load выберите сигнал из списка Waveform . 

4. Щелкните по кнопке ОК. 

5. Щелкните по кнопке Run для запуска генерации сигнала. 

Для оптимизации сигнала выберите Edit»Device Configuration и подкорректируйте 

настройки. 

Драйвер измерительных приборов NI-FGEN 
Вы можете программно управлять генератором сигналов, используя поставляемый драйвер 

PXIe-5423 взаимозаменяемых виртуальных измерительных приборов (IVI) и систему 

автоматизированного проектирования (ADE). 

API NI-FGEN имеет набор операций и атрибутов, которые реализуют все функциональные 

возможности оборудования PXIe-5423, включая конфигурирование, управление и другие, 

специфичные для модели функции. 

Вы можете запустить примеры NI-FGEN, чтобы просмотреть основные приложения 

генератора сигналов. Примеры демонстрируют функциональность PXIe-5423 и служат 

моделями программирования и стандартными блоками для ваших собственных приложений. 

Примеры LabVIEW, LabWindows/CVI, C и .NET находятся в папке Пуск»Все 

программы»National Instruments»NI-FGEN»NI-FGEN Examples. 

Генерация сигналов с NI-FGEN и LabVIEW 

1. Запустите LabVIEW. 

2. Выберите Help»Find Examples. 

3. Выберите Hardware Input and Output»Modular Instruments»NI-FGEN (Signal 

Generators)»Arbitrary Waveform Generation. 

4. Дважды щелкните по примеру, чтобы его открыть. 

Пример Fgen Basic Arb Waveform демонстрирует, как начать работу в режиме генерации 

сигналов произвольной формы.  

5. Выполните следующие действия на блок-диаграмме. 

6. В выпадающем меню Resource Name выберите имя PXIe-5423, назначенное в MAX. 

7. Щелкните по кнопке Run для запуска программы-примера. 
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Решение проблем 
Если после завершения процедуры устранения неполадок проблема не исчезнет, обратитесь в 

службу технической поддержки NI или посетите сайт ni.com/support. 

Почему светодиод ACCESS выключен, когда шасси 
включено? 
Светодиод может не загораться до того момента, пока модуль не сконфигурирован в MAX. 

Прежде чем продолжать, убедитесь, что PXIe-5423 появляется в MAX. 

Если светодиод ACCESS LED не загорается после включения питания шасси, проблема 

может заключаться в шинах питания шасси, в модуле или в самом светодиоде. 

Внимание! Подключайте внешние сигналы только когда включено питание  

PXIe-5423. Подключение внешних сигналов к выключенному устройству может 

привести к его повреждению. 

1. Отключите все сигналы от передней панели модуля. 

2. Выключите питание шасси. 

3. Извлеките модуль из шасси и осмотрите его на предмет повреждений. Не устанавливайте 

поврежденный модуль. 

4. Установите модуль в другой слот шасси. 

5. Включите питание шасси. 

Примечание: При использовании ПК с устройством для дистанционного 

управления системой PXI, включите питание шасси до включения питания 

компьютера. 

6. Проверьте, появляется ли модуль в MAX. 

7. Выполните самотестирование. 

Если светодиод ACCESS по-прежнему не загорается и ошибка остается, свяжитесь с 

технической поддержкой NI или посетите страницу ni.com/support. 

 

Дополнительная информация  

Схема расположение контактов и светодиоды PXIe-5423 на странице 7 
 

Что делать, если PXIe-5423 не появляется в MAX? 

1. В дереве Configuration MAX раскройте ветвь Devices and Interfaces. 

2. Разверните дерево Chassis, чтобы увидеть список установленных устройств, и нажмите 

на клавишу <F5>, чтобы обновить список. 

3. Если модуля по-прежнему нет в списке, выключите питание системы, убедитесь, что все 

оборудование установлено правильно, и выполните перезагрузку. 

4. Перейдите в диспетчер устройств. 

 

 

http://www.ni.com/support
http://www.ni.com/support
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Операционная 

система 
Описание 

Windows 10/8.1 Щелкните правой кнопкой мыши по кнопке Пуск и выберите 

Диспетчер устройств 

Windows 7 Выберите Пуск»Панель управления»Диспетчер устройств 

 

5. Убедитесь, что PXIe-5423 виден в диспетчере устройств. 

a) Убедитесь, что под строкой NI имеется пункт PXIe-5423. 

Примечание: Если вы используете ПК с устройством дистанционного 

управления системой PXI, убедитесь также, что в разделе System Devices нет 

ошибок в пункте PCI-to-PCI Bridge. 

b) Если ошибки есть, переустановите NI-FGEN и PXIe-5423. 

 

Что делать, если PXIe-5423 не прошел 
самотестирование или самокалибровку? 

1. Перезагрузите систему. 

2. Запустите MAX и проведите повторное самотестирование или самокалибровку 

устройства. 

3. Выключите питание шасси. 

4. Установите модуль в другой слот. 

5. Включите питание шасси. 

6. Снова выполните самотестирование или самокалибровку. 
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Куда обратиться далее  

На следующем рисунке показано, куда обратиться за получением дополнительной 

информации об использовании PXIe-5423. 

Рисунок 4. Ресурсы для PXIe-5423 
 

 

Лицензирование прошивки PXIe-5423  

Программное обеспечение лицензируется в соответствии с лицензионными соглашениями на 

программное обеспечение, предоставляемыми с программным обеспечением, или, в случае 

отсутствия таковых, с Лицензионным соглашением на программное обеспечение National 

Instruments, доступным на сайте ni.com/legal  на момент покупки. 

Для получения копии лицензий на программное обеспечение, относящихся к прошивке 

данного аппаратного продукта, а также копий лицензий сторонних производителей и любых 

необходимых уведомлений, поставляемых с прошивкой, посетите сайт ni.com/info и введите 

информационный код PXIe5423ThirdPartyLicensing. 

  

http://www.ni.com/legal/
http://www.ni.com/info
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Всемирная поддержка и обслуживание  

Веб-сайт NI является полноценным ресурсом вашей технической поддержки. На странице 

ni.com/support вы можете получить любую информацию, начиная с выявления 

неисправностей и ресурсов для самостоятельного поиска ответов по разработке приложений 

и заканчивая возможностью поддержки по электронной почте либо по телефону 

специалистами NI. 

Посетите страницу ni.com/services для получения услуг заводской сборки NI, ремонта, 

расширенной гарантии и др. 

Посетите страницу ni.com/register для регистрации вашего продукта NI. Регистрация 

продукта облегчает техническую поддержку и гарантирует, что вы будете получать важные 

обновления от NI. 

Declaration of Conformity (Декларация о соответствии) – это наше заявление о соответствии 

требованиям Совета Европейских сообществ к производителям. Эта система обеспечивает 

защиту пользователя от проблем электромагнитной совместимости (EMC) и безопасности 

продукта. Вы можете получить декларацию о соответствии вашего продукта на странице 

ni.com/certification. Если ваш продукт поддерживает калибровку, вы можете получить его 

калибровочный сертификат на странице ni.com/calibration. 

Штаб-квартира корпорации NI расположена по адресу 11500 North Mopac Expressway, Austin, 

Texas, 78759-3504. National Instruments имеет также офисы по всему миру. Для получения 

поддержки по телефону в США создайте запрос на странице ni.com/support или позвоните по 

номеру 1 866 ASK MYNI (275 6964). Для получения поддержки по телефону вне США 

посетите раздел Worldwide Offices на странице ni.com/niglobal для доступа к веб-сайтам 

филиалов, где имеется обновляемая контактная информация, телефоны службы поддержки, 

адреса электронной почты и информация о текущих событиях 

 

http://www.ni.com/support
http://www.ni.com/services
http://www.ni.com/register
http://www.ni.com/certification
http://www.ni.com/calibration
http://www.ni.com/support
http://www.ni.com/niglobal


 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Информация может быть изменена без уведомления. Обратитесь к документу NI Trademarks and Logo Guidelines на сайте 
ni.com/trademarks для получения дополнительной информации о торговых марках National Instruments. Названия других 

упомянутых в данном руководстве изделий и производителей являются торговыми марками или торговыми именами 

соответствующих компаний. Для получения информации о патентах, которыми защищены продукция или технологии National 
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ni.com/patents. Информацию о лицензионном соглашении с конечным пользователем (EULA), а также правовые положения 

сторонних производителей вы можете найти в файле readme вашего продукта NI. Обратитесь к документу Export Compliance 

Information на странице ni.com/legal/export-compliance за глобальными принципами торговой политики NI, а также для 

получения соответствующих кодов HTS, ECCN и других данных об экспорте/импорте. NI НЕ ДАЕТ НИКАКИХ ЯВНЫХ ИЛИ 

ПОДРАЗУМЕВАЕМЫХ ГАРАНТИЙ ОТНОСИТЕЛЬНО ТОЧНОСТИ ЭТОЙ ИНФОРМАЦИИ И НЕ НЕСЕТ ОТВЕТСТВЕННОСТИ ЗА 

ЛЮБЫЕ ОШИБКИ. Для покупателей из правительства США: Данные, содержащиеся в этом руководстве, были разработаны на 

личные средства и подпадают под действие применимых ограниченных прав и ограниченных прав на данные в порядке, 

предусмотренном законами FAR 52.227-14, DFAR 252.227-7014 и DFAR 252.227-7015. 
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